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About this guide
This document is a global document. Contact your system supplier or your 
Nortel Networks representative to verify that the hardware and software 
described are supported in your area.

Target audience
The Meridian Companion DECT Overview guide provides information for 
sales representatives, planners, installers, site maintenance personnel and 
administrators.

Identifying Nortel Networks PBX systems
The following systems are referred to in this guide as large systems:

• Option 51

• Option 61

• Option 71

• Option 81

• Option 51C

• Option 61C

• Option 81C

The following systems are referred to as small systems.

• Option 11

• Option 11E

• Option 11C
DECT Overview
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• Option 11C Mini

• Succession Communication Server for Enterprise 1000

Call out boxes

CAUTION:  Data loss
This symbol alerts you to a procedure that can result in a loss of data.

CAUTION:  Equipment damage
This symbol alerts you to a procedure that can result in equipment 
damage.

CAUTION:  Electrostatic sensitive device
This symbol alerts you to a procedure that can result in equipment 
damage due to ElectroStatic Discharge (ESD).

CAUTION:  Service interruption
This symbol alerts you to a procedure that can result in an interruption of 
service.

DANGER:  Electric shock
This symbol alerts you to the risk of a serious injury, or death, caused by 
an electric shock.

DANGER:  Serious injury
This symbol alerts you to the risk of a serious injury, or death, caused by 
an immediate hazard.
553-3601-103 Standard 5.00 September 2002
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WARNING:  Personal injury
This symbol warns you to the risk of a minor or moderate injury caused by 
an immediate hazard.
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Introduction
The DECT system allows users to move freely about their work sites while 
conducting telephone conversations using wireless handsets. DECT is an 
acronym for Digital Enhanced Cordless Telecommunications.

Figure 1
Main parts of the DECT system

The DECT system is in a large system IPE shelf or a small system 
cabinet/chassis. The DECT system has four main components:

a. DECT mobility cards

b. base station

c. Optivity Telephony Manager (OTM) with DECT application

d. handsets
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DECT Mobility Card (DMC8)

Figure 2
DECT Mobility Card 

The NTCW00AB DMC8 DECT Mobility Card provides an interface 
between the large system or small system and the base stations.

A DMC8 card supports up to eight base stations.

The DECT system supports a mix of DMC and DMC8 cards. (The DMC card 
is a retired card that is no longer available.)

All DMC8s support a Point-to-Point Protocol (PPP) connection to the DECT 
Manager with an NTCW12DA cable. The DMC8 card requires a 
NTCW25AA DECT Manager Ethernet (DME) daughterboard installed to 
support an Ethernet connection.

Each DMC8 card is programmed in the large system and small system 
database using LD 10.

The DMC8s are interconnected by faceplate cables, allowing them to pass 
information to each other.

DMC8s must be in an IPE shelf in a large system or in a small system 
cabinet/chassis.

DMC

553-8165.EPS
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There is no call switching in the DMC8 card. All call switching occurs within 
the large system and small system.

DECT Mobility Card options

Figure 3
DMC8 options

The component side of the DMC8 contains jumpers J1, J2, and J3. The 
jumpers indicate card status as follows:

• J1 for pre Release 23 software or post Release 23 software
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• J2 for a card installed in either a small system or large system

• J3 for a card installed in either DECT shelf 0 or DECT shelf 1

• J6 to J9 which select either a V.24 connection or an Ethernet connection 
for the OTM DECT Manager. This allows I/O panel connections to 
support eight signals (four V.24 or four Ethernet).

DECT Mobility Card – Expander (DMC8-E)

Figure 4
DECT Mobility Card – Expander

The NTCW01AB DMC8-E DECT Mobility Card-Expander provides the 
same functions as a DMC card.

The DMC8-E has additional circuitry required to regenerate faceplate cable 
signals when a system contains more than eight DMC8s. The DMC8-E 
connects two shelves or cabinets in a DECT system.

DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8
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If the DMC8-E is used in an IPE module, it must be located in card slot 8. If 
the DMC-E is used in an small system cabinet/chassis, it must be located in 
card slot 9, 19 or 29.

Do not install a DMC8 in slot 8 of an IPE module. Do not install a DMC8 in 
slot 9, 19 or 29 of a small system cabinet/chassis.

An NTCW25AA DME daughterboard is required to provide Ethernet OTM 
access. The daughterboard is also required to enable DECT Messaging. The 
DME daughterboard is not required for serial OTM access. Only one DME 
daughterboard is required per system.

DMC8 and DMC8-E faceplate features
Figure 5 on page 21 shows the following DMC8 and DMC8-E faceplate 
features:

a. red LED (indicates the same status as all IPE cards)

b. yellow LED (indicates DECT sub-system status)

c. green LED (indicates DECT sub-system status)

d. DMC8 to DMC8 faceplate cable port 

e. DMC8 bypass faceplate cable port 

f. DMC8-E to DMC8-E faceplate cable port 

g. for future use
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Figure 5
DMC8 and DMC8-E faceplate features
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Faceplate cables
The faceplate cables form the 20 Mb/s bus that connects all DMCs. The 
faceplate cables meet the standard for Unshielded Twisted-Pair category of 
performance 5 (UTP Cat 5).

Signalling and PCM are sent to all DMCs over the faceplate cables, allowing 
a DMC8 to pass a call to another DMC8.

The cables shown in Figure 6 on page 22 are as follows:

a. DMC8 to DMC8 faceplate cable

b. DMC8 to DMC8-E faceplate cable

c. DMC8 faceplate termination 

d. DMC8 bypass faceplate cable

Figure 6
Faceplate cables

The DMC8 to DMC8 cable extends the 20Mb/s bus to all DMCs.

The DMC8 to DMC8-E cable extends the 20Mb/s bus past the XPEC card. A 
small system does not require the DMC8 to DMC8-E cable.
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The DMC8 faceplate termination balances the impedance at either end of the 
20Mb/s bus.

The DMC8 bypass faceplate cable bypasses DMC8s to be inserted in or 
removed from an operational system. The DMC8 bypass faceplate cable is 
shown in Figure 6 on cards 10 and 12.

The DMC8-E to DMC8-E faceplate cable connects two shelves or two 
cabinets. The DMC8-E to DMC8-E faceplate cable is shown in Figure 8 on 
page 25.

The faceplate cabling layout plan must specify that the DMC8 to DMC8-E 
cable connects into the ports as shown in Figure 6 on page 22.

Inter-shelf or cabinet faceplate connections

CAUTION:  Service interruption
Customers must use UTP Cat 5 faceplate cables supplied by Nortel 
Networks. Faceplate termination must be used on the DMCs at both ends 
of the faceplate cabling.

CAUTION:  Service interruption
The DMC8-E to DMC8-E faceplate cable has four sets of movable ferrites. 
The position of the ferrites on the cable is important. See Figure 7 on page 
24. Each end of the cable must have a group of 20 ferrites. One quarter the 
distance from each end of the cable must have a group of 10 ferrites. The 
maximum length of the cable is 1.5 meters, limiting the position of DECT 
shelves 0 and 1 to adjacent IPE modules or small system cabinets/chassis.
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Figure 7
Cable ferrites
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Figure 8 shows the following:

a. DECT shelf 0

b. DECT shelf 1

c. DMC8-E to DMC8-E faceplate cable connection between 
DMC8-Es on DECT IPE shelves.

Figure 8
IPE inter-shelf faceplate connections
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Figure 9 shows the following:

a. Option 11C main cabinet

b. Option 11C expansion cabinet

c. Option 11C second expansion cabinet

d. the DMC8-E to DMC8-E faceplate cable connection between the 
DMC8-Es on the first and second Option 11C cabinets

Figure 9
Option 11C inter-cabinet faceplate connections
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Base Stations

Figure 10
Base Station

There are three base station models available: 

• the C4600 which supports six active call radio links

•  the C4610 base station which supports 12 active call radio links

• the C4610E base station (with external antenna) which supports 12 active 
call radio links

The base stations are IP40-compliant wall-mounted transceivers that provide 
digital radio links to handsets. 

CAUTION:  Service interruption

For maximum line length before signal degradation occurs, use UTP Cat 
5 cabling between the base station and the shelf or cabinet. If the line 
length exceeds 100 ohms for the 4610 base station, an external power 
supply must be used. The maximum distance when using external power 
with UTP Cat 5 cabling is approximately 1.7 km.
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The base station has the following features:

• an RJ-45 socket connection to a one meter UTP Cat 5 cable

• an RJ-45 socket connection to an external or local power supply

• a green LED (C4600) or a yellow LED (C4610), which when lit, 
indicates synchronization to its DMC8

• a one meter UTP Cat 5 cable connected through an RJ-45 wall socket and 
MDF to an IPE I/O panel or small system cabinet I/O panel 

Two sources can power the base station:

• the DMC8 and DMC8-E feeding phantom power over the UTP Cat 5 
cable signaling pairs, connected to (a) in Figure 10 on page 27

• a local power supply, connected to (b) in Figure 10 on page 27

Base stations connected to a DMC8 or DMC8-E card can use phantom power 
in some conditions, and must use local power in other conditions. An 
application on the Optivity Telephony Manager (OTM) can enable or disable 
phantom power.

Note: The maximum line length for a twelve-channel base station using 
phantom power is 1.0 km. The maximum line length for a six-channel 
base station, regardless of power, or a twelve-channel base station using 
external power, is 1.7 km.

DMC8 card engineering guidelines
This section describes the recommended engineering guidelines for the 
installation of phantom powered base stations. 

The optimum capacity mix of 6-channel and 12-channel base stations is six 
6-channel and two 12-channel base stations. Using three or more 12-channel 
base stations per DMC8 card is possible, but is not an efficient use of the 32 
channels on the DMC8 card.

Nortel Networks recommends that the 12-channel base stations be distributed 
over the DMC8 cards.
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Table 1 lists engineering guidelines for various deployments of 
phantom-powered base stations.

Table 1
DMC8 engineering guidelines for 6-channel RFP (base station) and 12-channel RFP (base 
station)

System
Number of base stations that can be phantom 
powered per shelf or cabinet

Total

Meridian 1
eight 6-channel or six 6-channel + two 12-channel 
@ 0.5 km

128

seven 6-channel or five 6-channel + two 12-channel 
@1.0 km

112

seven 6-channel @ 1.7 km 112

new base stations – any mix at 1.7 km 128

Option 11C
seven 6-channel or five 6-channel + two 12-channel 
@ 0.5 km

70

six 6-channel or four 6-channel + two 12-channel 
@1.0 km

60

six 6-channel @ 1.7 km 60

new base stations – any mix at 1.7 km 80

Option 11C Mini
eight 6-channel or six 6-channel + two 12-channel 
@ 0.5 km

32

eight 6-channel or six 6-channel + two 12-channel 
@ 1.0 km

32

eight 6-channel @ 1.7 km 32

new base stations – any mix at 1.7 km 32

Succession CSE 
1000

eight 6-channel or six 6-channel + two 12-channel 
@ 0.5 km

32

eight 6-channel or six 6-channel + two 12-channel 
@ 1.0 km

32

eight 6-channel @ 1.7 km 32

new base stations – any mix at 1.7 km 32
DECT Overview



Page 30 of 164 DECT
Using the maximum of eight base stations on a DMC8 card imposes 
engineering restrictions on the remaining slots, as listed in Table 2 

Table 2
DMC8 card Ordering Tool – system slot restrictions for different base station lengths

System
Base station 
average line 
length

Number of unoccupied slots required

Meridian 1
0.5 km no restrictions

1.0 km for every 1 – 15 slots, one slot must be unoccupied

1.7km for every 1 – 6 slots, one slot must be unoccupied

Option 11C
0.5 km for every 1 – 9 slots, one slot must be unoccupied

1.0 km for every 1 – 8 slots, one slot must be unoccupied

1.7km for every 1 – 15 slots, one slot must be unoccupied

Option 11C Mini
0.5 km no restrictions

1.0 km no restrictions

1.7km no restrictions

Succession 
CSE 1000

0.5 km no restrictions

1.0 km no restrictions

1.7km no restrictions
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Netprice Order Tool
The Netprice Order Tool makes certain approximations in provisioning 
DMC8 cards. This provides a simplified configuration that meets the needs 
of most sites.

DECT on Meridian 1
The Order Tool allows the first 80 base stations to be phantom powered. 
When more than 80 base stations are requested, the extra base stations are 
assumed to be local powered. Power adapters are provided as follows:

• C4610 ac adapters 
= (sum of 6-channel and 12-channel base stations) – 80

• adapters must be purchased separately

Note: Because it is not possible to determine how the cards are spread 
over the two shelves, it is assumed that there are 80 phantom powered 
base stations per system.

DECT on Option 11C
The Order Tool allows the first 40 base stations to be phantom powered. 
When more than 40 base stations are requested, the extra base stations are 
assumed to be local powered. Power adapters are provided as follows:

• C4610 ac adapters 
= (sum of 6-channel and 12-channel base stations) – 80

• adapters must be purchased separately

DECT on Option 11C Mini
All base stations can be powered from the cabinet power supply.

DECT on Succession CSE 1000
All base stations can be powered from the Media Gateway power supply.

Rules with new base stations
With the new base stations, the provisioning rules are relaxed to allow the 
maximum number of base stations to be provisioned for each shelf, without 
the requirements.
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Base station housing

Figure 11
Base station environmental housing

The environmental housing is IP66 compliant. 

The housing must be used indoors if a base station is subject to conductive 
pollution, or outdoors if base stations are mounted externally.

The environmental housing kit includes all of the relevant cables and 
installation material. 

The environmental housing mounts to existing walls.

Signaling lines provide power to the external base stations.

553-8206a.EPS
553-3601-103 Standard 5.00 September 2002



DECT Page 33 of 164
Base Station cell

Figure 12
Base Station cell

A base station cell is the radio signal area covered by a single base station. 
The base stations are positioned so the cells overlap. A DECT handset can 
make and receive calls when it is within a base station cell. When the handset 
moves from one cell to another, the cell overlap allows the handset to move 
without interruptions.

The cell radius varies from 20m to 100m.

The number of base stations required to cover a certain area depends on many 
factors, such as the following:

• size of the area of coverage

• radio propagation characteristics of the buildings

• materials used for walls, floors, lift shafts, reinforced glass, doors 
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• strong magnetic fields from radar, welding equipment, manufacturing 
equipment, and high energy electronic devices

• density of telephone users in an area and amount of telephone traffic

DECT handsets
Four handset models are available: 

• C4010

• C4010 Ex

• C4020

• C4050

The handsets are battery-powered, pocket-sized, portable telephones.

Subscription and De-subscription
Subscription is the process of adding a handset to a DECT system. The 
handset can then make and receive calls.

A user can subscribe a handset to more than one DECT system. This feature 
is useful for a company that has multiple DECT sites. See “Multi-Site 
Mobility Networking” on page 147.

De-subscription is the process of removing a handset from a DECT system. 
The handset user is then prevented from making and receiving calls.

Note: Refer to the C4010/C4020 Cordless Handset User Guide, and the 
C4050 Handset User Guide for a detailed description of how to use 
handset features and the features available from the large systems and 
small systems.
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The DECT C4010 handset, C4010 Ex handset, and 
C4020 handset

The C4010 is the base model. The C4010 Ex and C4020 handsets have 
additional features or features that are different from the C4010 model. The 
C4010 Ex design lets it operate safely in an explosive atmosphere. The C4020 
accepts a headset and has a vibrate alert feature.

Figure 13
DECT C4010 handset and C4010 Ex handset
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Handset attributes

• up to 8 hours talk time

• up to 60 hours standby mode

• up to 8 days power-save standby mode (cannot receive calls in this mode)

• subscribe to a maximum of 8 DECT systems

• directory dialling from a 20-name phone book

• off-hook number preparation with correction option

• last number re-dial

• recall

• automatic encryption

• adjustable alerter volume

• adjustable ear-piece volume in 5 steps

• six ringing melodies

• manual ringer mute on incoming calls

• handsfree operation

Power supply

• 3.6V/600mAh NiMh rechargeable battery pack

Dimensions

• handset 135 x 58 x 19 mm

• charger 85 x 75 x 50 mm

Color and finish

• the C4010 and C4020 handset color is charcoal grey, with a non-gloss 
finish

• the C4010Ex handset is yellow
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Weight

• handset 135 g

Accessories

• belt clip

• headset for the C4020 only

Figure 14
C4010 battery charger

C4010 battery charger

• desktop or wall mounted battery charger

• mains supply required is 230V/50 Hz

• power consumption 
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The C4050 handset

Figure 15
C4050 handset

Handset attributes

• up to nine hours speech time

• standby time of up to 130 hours

• subscribe to a maximum of 10 DECT systems

• local directory with alpha search function for 100 entries

• incoming call indication LED light-ring (red)

• charging indication LED light-ring (green)

553-A0079
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• visual and audible incoming call signal

• volume control during a call

• name display (16 characters) and number display (32 digits)

• last number redial for up to 20 entries

• caller list of 20 calls

• caller filter for 10 entries with on/off settings

• re-dial function for up to 20 entries

• on-hook number preparation

• microphone mute

• prompts in ten languages

• Calling Line Identification (CLID) 

• key click on or off

• automatic off-hook on an incoming call, selectable

• keypad lock

• headset option

• ringer, 30 melody selectable

• ringer volume control, off, plus seven steps

• tone ringing through the headset in normal speech volume

• ringer mute while charging, selectable

Power supply

• two standard AAA 650 mAh NiMh rechargeable batteries

Dimensions

• handset 140 x 51 x 25.5 mm

• charger 130 x 82 x 65 mm
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Color and finish

• the handset color is dark grey and silver with a non-gloss finish

Accessories

• belt clip

• carry case

• headset

• desktop charger

• data charger and data cable

Figure 16
C4050 charging rack

C4050 battery charger

• charging time maximum eight hours

• spare batteries have a 24 hour charging time
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System synchronization
Clock requirements

The following clock controller cards are mandatory:

• QPC775 Clock Controller card for a large system

• NTAK20BC Clock Controller Daughter-board or NTAK79AA card with 
a built-in clock controller for a small system

If there is no digital connection to the network, the appropriate clock 
controller must be installed and operated in free run mode.

Note: On EMC-hardened Option 11C systems, the clock controller must 
be in one of the first three slots of the CPU cabinet.

Figure 17
DECT synchronization

DECT synchronization port 
Where multiple DECT systems share the same radio coverage area, the 
DECT synchronization port must be used. The DECT synchronization port is 
accessed through an MDF connection. Failure to connect the DECT 
synchronization ports of each system can lead to service interruptions.

DECT
DMC
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System hardware parameters
Tables 3, 4, 5, and 6 detail the minimum and maximum configurations for the 
DECT system with the Concentration feature. 

†Due to number of Virtual TNs available. Subject to engineering rules and constraints. 

†Due to number of Virtual TNs available. Subject to engineering rules and constraints.  

Table 3
Minimum configuration

System type
Shelves 

or 
cabinets

DMC8 DMC8-E
Base 

stat ion
Handset

All systems 1 1 0 1 to 8† 1 to 510†

Table 4
Maximum large system configuration

System type Shelves DMC8 DMC8-E Base 
stat ion

Handset

Large system 2 30 2 256† 16,320†
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*One of the DMC8 positions in the CPU cabinet is required by the NTAK20 Clock 
Controller Daughterboard.

** DECT can only exist in one cabinet. The cabinets cannot be joined.

†Due to number of Virtual TNs available. Subject to engineering rules and constraints. 

† Due to number of Virtual TNs available. Subject to engineering rules and 
constraints.

***  DECT can only exist in one Media Gateway. The Media Gateways cannot be 
joined.

If a cabinet or Media Gateway has a “9th slot”, the slot must be provisioned 
with a DMC8-E card. All other cards are DMC8s.

Table 5
Maximum Option 11 configuration

System type Cabinets DMC8 DMC8-E
Base 

stat ion Handset

Option 11E, 11C not using 
CPU cabinet

2 18 2 160† 640†

Option 11 or 11E, 11C if 
CPU cabinet is used

2 17* 2 152† 640†

Option 11C Mini (Main cab-
inet)

1** 3* 0 16† 640†

Option 11C Mini (Expan-
sion cabinet)

1** 3* 1 32† 640†

Table 6
Maximum Succession CSE 1000 configuration

System type Cabinets  DMC8 DMC8-E
Base 

stat ion
Handset

the first Media Gateway 1*** 3 1 32† 640†

all other Media Gateways 1*** 4 0 32† 640†
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The DECT system components have the following capacities:

• one NTCW00AB DMC8 or one NTCW01AB DMC8-E can support up 
to 8 base stations

• one C4600 base station can support 6 active calls

• one C4610 base station can support 12 active calls

• one C4610E base station can support 12 active calls

Multiple DECT systems can co-exist in the same PBX system if they are 
synchronized to the same clock source. However, from a user’s perspective, 
the DECT systems are separate.

System software parameters
The software that operates the DECT system resides as firmware in the 
DMCs. The firmware consists of an operating program and a system database 
configuration. The operating program controls base station and handset 
functions. The operating program also communicates with the Meridian 1 
and the DECT Manager. The system data defines hardware and hardware 
addressing.

The DECT system is compatible with Meridian PBX systems running 
Release 23 and later software.

The DMC8/DMC8-E with the ensuing software releases supports the 
following:

• Release 23 can support basic configuration, CLID and CPND, DECT 
card addressing within OA&M, and 16 users on each card.

• Release 24.2x can support up to 32 handsets on each card.

• Release 25.xx can support up to 510 handsets with Concentration and 
MSMN.
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Site planning
Contents

This section contains information on the following topics:

Site survey. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Customer requirements. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

On-site contact. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Site plans. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Building details. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Position and use of available cabling. .  . . . . . . . . . . . . . . . . . . . . 47
Radio coverage. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Number of handset users. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Number of cells required to support traffic. .  . . . . . . . . . . . . . . . . . . 48
Customer review. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Deployment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
The DECT deployment tool. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
The deployment process. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Identifying initial critical points on the floor plan. .. . . . . . . . . . . 52
Locating cell centers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Determining cell boundaries. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
Identifying additional critical points and cell boundaries. . . . . . . 55
Marking the points, centers, and boundaries on the floor plan. . . 56
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Site survey
A site survey determines customer requirements, and the number of cells 
required to support traffic. After a site survey is completed, a customer review 
is required.

Customer requirements
The customer must provide the following:

• a site contact name and telephone number

• site plans

• building details

• information on available house cabling

• radio coverage requirements

• number of users

On-site contact
The on-site contact provides the following:

• time and date scheduling

• access to restricted or locked areas

• additional information when required

Site plans
A complete set of site plans are required. Dimensions must be clearly stated 
on the plans. 

Building details
System deployment and installation depends upon the following building 
details:

• building identification 

• construction materials, such as walls, floors, ceilings

• type of use, such as an office, hotel, factory, or store

• dimensions
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• number of floors

• height of floors

• partitioning of floors

Position and use of available cabling
Cables that connect the base station to the DECT System must meet or exceed 
the UTP Cat 3 standard. UTP Cat 5 is recommended as it provides a greater 
line length before signal degradation occurs. New cabling is required if the 
existing cabling does not meet the standard.

Radio coverage
A base station coverage list is required to indicate the following:

• areas where radio coverage is required

• areas excluded from radio coverage due to the proximity of sensitive 
electronic equipment

• areas where radio coverage is not required

• areas where radio coverage is not feasible or requires specific base 
stations

• objects inside buildings

• details of furniture, cupboards, and machinery on every floor of the 
building’s interior

Base station installations can be required to be out of sight. A customer could 
request base stations to be mounted in unsuitable locations, such as stone 
columns, air ducts or horizontally on the ceiling. Radio coverage cannot be 
guaranteed when base stations are mounted in unsuitable locations.

Know in advance where coverage is required. Some examples of coverage 
areas are:

• elevators

• stairwells

• toilets

• outdoor areas 
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Number of handset users
The following information must be available:

• the number of handset users

• the potential growth of handset users

• the areas of above average and below average traffic density

Number of cells required to support traffic
Traffic requirements are determined for each cell. The deployer will calculate 
system requirements to support user traffic.

Customer review
After the site survey and before the deployment process, the person deploying 
the site must review coverage requirements with the customer representative. 
The person deploying the site must explain to the customer representative 
how the survey is conducted. The customer representative must tell fellow 
employees that a person deploying the site will be taking measurements in 
their work place.

Deployment
A deployment determines the locations of base stations and cells. The 
deployment process consists of the following activities:

• identifying initial critical points on the floor plan

• locating cell centers

• determining cell boundaries

• identifying additional critical points and cell boundaries

• marking the points, centers, and boundaries on the floor plan

Deployment terms are as follows:

• coverage area – an area where a handset can be used to make and receive 
calls

• cell – the coverage area provided by the base station antennas
553-3601-103 Standard 5.00 September 2002



Site planning Page 49 of 164
• cell boundary – the parameter of a cell coverage area

• critical point – a point or location defined as the extreme corner of a 
coverage area, that can be difficult for the radio signal to reach

• cell center – the installation point of the base station serving the cell

• range – the distance from a cell centre to its cell boundary

Figure 18 on page 49 illustrates these terms.

Figure 18
Example showing deployment terms
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The DECT deployment tool
The DECT deployment tool is used to locate cell centers and determine cell 
boundaries.

Figure 19
Deployment tool
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The deployment tool is stored and transported in a yellow protective case. The 
deployment tool consists of the following components:

a. base station

b. power cord 

c. battery

d. battery mount

e. adjustable tripod 

f. extender arm connector

g. extender arm swivel and clamp

h. extender arm

i. battery charger (separately ordered)

j. battery charger cable

k. deployment handset

l. deployment handset battery charger

The deployment process
The deployment process consists of the following steps:

• Identifying initial critical points on the floor plan (page 52)

• Locating cell centers (page 53)

• Determining cell boundaries (page 54)

• Identifying additional critical points and cell boundaries (page 55)

• Marking the points, centers, and boundaries on the floor plan (page 56)
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Identifying initial critical points on the floor plan
A critical point is a place that can be difficult for the radio signal to reach, 
such as a corner of a room, lifts and stairwells. Initial critical points are shown 
in Figure 20 as P1, P2, P3, and P4. 

Figure 20 shows the following:

a. stairwell

b. second floor plan

Figure 20
Critical points
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Locating cell centers
Figure 21 shows the following:

a. stairwell

b. second floor plan

A cell center is located by placing the deployment tool at one critical point, 
for example P1, then using the deployment handset to obtain a change in 
audio quality. The audio quality change determines the cell boundary 
contour. This process is repeated at an adjacent critical point, for example P2. 
Where the cell boundaries of both critical points meet is the cell center. The 
cell center position is marked on a floor plan. The cell center determines the 
location of a base station, shown in Figure 21, as arc 2C1.

Figure 21
Cell centers
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Determining cell boundaries
Figure 22 shows the following:

a. stairwell

b. second floor plan

A cell boundary for the cell center is determined by placing the deployment 
tool at the cell center, for example 2C1, and using the deployment handset to 
establish the cell boundary. The cell boundary contour is marked on the floor 
plan, and shown in Figure 22 by a dash-dot line.

Figure 22
Cell boundaries
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Identifying additional critical points and cell boundaries
Figure 23 shows the following:

a. stairwell

b. second floor plan

Additional critical points, shown in Figure 23 as P5, P6, P7, and P8, are 
identified to ensure base station radio coverage for the entire area.

Figure 23
Additional critical points and cell boundaries
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Marking the points, centers, and boundaries on
the floor plan

Figure 24
Points, centers, and boundaries on the floor plan
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• 2C1 and 2C2 show cell centers or base station locations.

• Dashed and dotted lines show cell boundaries.

• Additional critical points are shown at P5 P6 P7 P8.

• 2C3 and 2C4 cell centers provide full coverage of the floor.
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Two copies of the floor plan are required. One copy is used during the site 
planning. The second copy is marked with the information from the site 
planning copy and attached to DECT Provisioning Records (553-3601-102) 
for the installer.
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64
System installation
Contents

This chapter contains information on the following topics:

Hardware Installation. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
Install Base Station. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
Install additional IPE shelves or cabinets. .. . . . . . . . . . . . . . . . . . . . 60
Install DMC8 cards and faceplate cables. . . . . . . . . . . . . . . . . . . . . . 60
Install OTM DECT application. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
Configure the DECT system on the OTM server. .. . . . . . . . . . . . . . 61
Configure handsets and retrieve subscription data. .. . . . . . . . . . . . . 61
Handset subscription. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
Base Station Power and Muting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Add a V.24 serial connection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Multi-Site Mobility Networking. .  . . . . . . . . . . . . . . . . . . . . . . . . . . 64

Reference list 
The following are the references in this section:

• DECT Installation Guide (553-3601-203)

Using the Provisioning Records, marked-up floor plans, and the site work 
order, the installation proceeds in the following order:

Hardware Installation 
• Before you begin 

• Unpack and examine the equipment
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Install Base Station

• Follow the DECT base station rules. 

• Install C4600 and C4610 base stations. 

— Install Base Station wiring to the MDF. 

— Install the C4610 base station external power supply. 

• Install base station in the external housing. 

• Attach the external housing to a wall. 

• Connect the external housing wiring to the MDF.

 

Install additional IPE shelves or cabinets 

• Install additional IPE modules. 

• Install additional cabinets. 

— Install IPE module wiring to the MDF. 

— Install cabinet wiring to the MDF. 

Install DMC8 cards and faceplate cables 

• Cross-connect base stations to the DMC8 card positions. 

• Cross-connect base stations to the DMC8 Relay card.

• Install DMC8 and DMC8-E cards in an IPE shelf (Option 51 to 81). 

• Install DMC8-E in an Option 11 or Succession CSE 1000 cabinet. 

• Install faceplate cables and inter-shelf/cabinet cable. 

Install OTM DECT application 

• Ensure the DECT application is on the OTM server.

— Ensure a communications profile is associated with the DECT 
application.
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— Add a communications profile for the DECT application.

— Add an Ethernet profile.

Configure the DECT system on the OTM server 

• Install the DME on the DMC8 Relay card.

• Change the DMC8 Relay card default IP address.

— Connect the DMC8 Relay card to a configuring PC.

— Reset the DMC8 Relay card default IP address to the LAN IP 
address.

• Connect the DMC8 Relay card to the OTM server.

• Launch the DECT application.

• Add the DECT system.

— Add General System Properties.

— Set the DECT system IP address to match the DMC8 Relay card.

— Add the Upstream Manager IP address, if required.

• Synchronize data with the DECT system.

— Synchronize DECT PARI and SARI.

— Synchronize DECT Parameters.

— Synchronize DECT Upstream Manager IP Address.

Configure handsets and retrieve subscription data 

• Configure non-concentrated handsets on a Meridian 1 PBX.

— Open the Station Administration window.

— Access Add Station dialog.

— Add 500 analog standard.

— Access features.

— Access the wireless type.
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— Select the wireless type.

— Select the DECT wireless set.

— Accept changes.

• Configure concentrated handsets on a Meridian 1 PBX (Release 25.15 or 
later).

— Open the Station Administration window.

— Access the Add Station dialog.

— Select Digital Cordless Set.

— Select Features.

— Select the wireless type.

— Select Visit or Local.

— Select an index.

— Provision hardware.

— Accept changes.

— Enable Single line features.

• Retrieve subscription data for handsets.

— Enable subscription.

— Activate the PIN on the handsets.

Handset subscription 

• C4010, C4010 Ex, C4020 handset subscription 

— Distribute C4010, C4010 Ex, C4020 handsets and install battery 
chargers.

— Subscribe the C4010, C4010 Ex, C4020 handset.
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• C4050 handset subscription 

— Distribute C4050 handsets and install battery chargers.

— Subscribe the C4050 handset.

Base Station Power and Muting 

• Open RFP (base station) window.

— Set alarm muting, line power, and comments for base station.

Add a V.24 serial connection 
DMC8 to OTM server serial connections:

• Connect the DMC8 Relay card to a local OTM server.

• Connect the DMC8 Relay card to a remote OTM server with modems.

• Install a virtual modem on the PC.

— Configure modem properties.

— Set modem speed.

— Set connection preferences.

— Disable flow control.

• Configure Remote Access Service (RAS).

— Set RAS modem and port usage.

— Configure RAS setup and network.

— Configure RAS services.

• Set up and configure a RAS Phone book entry.

— Open the Dial-up Networking dialog.

— Set up the phone book entry name.

— Set up the server dialog.

— Go to the next dialog.
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— Set up is complete.

— Configure the networking dial-up.

— Configure the Dial using entry.

— Configure the Dial-up server type.

— Configure the IP address.

— Accept the configuration changes.

— Establish the RAS connection.

— Establish a connection to the DECT system.

— Establish connection complete.

— Set the IP address through Telnet.

— Configure the IP address.

— Hang-up the RAS connection.

Multi-Site Mobility Networking 
For information on Multi-site Mobility Networking (MSMN) subscriptions, 
see “Multi Site Mobility Networking subscriptions” on page 118. 

For information on MSMN feature description, feature interaction, feature 
packaging, and operating parameters, see “Multi-Site Mobility Networking” 
on page 147. 

For information on MSMN feature implementation and operation, refer to 
“Multi-site Mobility Networking” in DECT Installation Guide 
(553-3601-203).
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146
Optivity Telephony Manager for DECT 
systems
Contents

This section contains information on the following topics:

Introduction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
DECT Application features. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
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OTM navigators. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
OTM server connections to DECT. .. . . . . . . . . . . . . . . . . . . . . . . . . 70

Access the DECT application with a Windows-based navigator. . . . . . 72
Login to the OTM. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
Select the Meridian 1 PBX that supports the DECT system. . . . . . . 74
Open DECT Application. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

DECT Systems window. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
Menu options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
Additional information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
DECT System Properties dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
Firmware upload and activation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99

Subscriptions window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
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Export DECT Subscriptions. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
Find DECT Subscriptions. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
Synchronize DECT and Station Administration Configuration. .. . . 116
Multi Site Mobility Networking subscriptions. .. . . . . . . . . . . . . . . . 118
Disable DECT Subscriptions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120
Force disable DECT Subscription. . . . . . . . . . . . . . . . . . . . . . . . . . . 121

Features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
DMC Boards window definition. .  . . . . . . . . . . . . . . . . . . . . . . . . . . 125
DECT Board properties sheet. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Radio Fixed Part (base station) window. . . . . . . . . . . . . . . . . . . . . . . . . 128
DECT Radio Fixed Parts (base station) properties sheet. . . . . . . . . . 131

Active Alarm Snapshot window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132
Features. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132
Menu options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
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Retrieve RSSI Snapshot window. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138
Retrieve RSSI Snapshot attributes. . . . . . . . . . . . . . . . . . . . . . . . . . . 140

Access the DECT application with a web-based navigator. .  . . . . . . . . 140
Administrator Login. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
Current Status. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142
System navigator. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
Alarm browser. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144
Web Access security. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145

Reference list
The following are the references in this section:

• Using Optivity Telephony Manager (553-3001-330)

Introduction
The Optivity Telephony Manager (OTM) provides a single point of access 
and control for many Meridian 1 applications.

OTM provides a DECT Application and OTM Common Services to manage 
a DECT system. OTM runs on Windows NT 4.0, Windows 98, and 
Windows 2000 as a server, plus Windows 95 as client.
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Note: For an overview of OTM, see Using Optivity Telephony Manager 
(553-3001-330).

DECT Application features
The DECT Application provides the following DECT management features 
and is used to:

• launch the Application from OTM using Windows and Web navigators

• view the DECT System provisioning using the DECT Systems window

• view the DMC8 configuration using the Boards window

• view base station configuration using the Radio Fixed Part window

• view subscription information using the Subscriptions window

• upgrade firmware using the DECT Systems window

• subscribe handsets using the Subscription window

• support DMC-8 and DMC (serial only) cards

• synchronize (update) the DECT Application database to the DECT 
system configuration when the OTM connects to the DECT system

• collect performance data using the Performance Collection window

• view On-line Help

Common Services features
The following DECT management features are provided by OTM Common 
Services:

• OTM Alarm Management provides alarm collection and alarm 
processing, as well as the following:

— a web-based alarm browser to view alarms, past alarms and 
occurring alarms

— a Windows-based alarm browser to view alarms that occur while the 
browser is open
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— an Alarm Notification application to notify personnel of an alarm 
occurrence by pager or E-mail. This application can forward the 
alarm to an upstream processor

— a PC Event log and Viewer to view events and alarms generated 
from the DECT Application in a report layout

• backup and restore to create and restore an OTM backup file of the 
DECT application data.

• user profiles to enable configuration of different types of DECT users 

• on-line help to provide help for common services features

For more information about the Common Services features, see Using 
Optivity Telephony Manager (553-3001-330).

OTM navigators
The DECT application uses two navigators to manage a DECT system:

• a Windows-based navigator

• a web-based navigator

A Windows based navigator, with the Microsoft Windows interface, can 
access all DECT application features. A web-based navigator, with the Web 
(http) interface, can access most, but not all, DECT application features.

Use the Windows-based navigator to manage a DECT system at the keyboard 
and mouse of an OTM server. See Figure 25 on page 71 and Figure 26 on 
page 72.

Use a web-based navigator to manage a DECT system from a client PC. See 
Figure 25 on page 71 and Figure 26 on page 72.

Features available to Windows-based navigators
The following features are only available at an OTM server using the 
Windows-based navigator. The OTM server enables the following:

• define DECT system sites

• define PBX system

• configure handsets with the Station Administration feature of OTM
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• OTM Alarm Notification

• PC Event log and Viewer

• backup and restore the DECT Manager database to and from a file

• define a user profile for Windows based applications

• define user management for Windows based applications

Features common to Windows- and web-based navigators
Provisioning features
The following are provisioning features common to Windows-based and 
web-based navigators:

• define DECT system

• DECT system names

• DECT Concentration mode

• DECT system Access Right

• transmission parameters

• DMC8 provisioning

• firmware provisioning

• base Station provisioning

Operation features
The following are operation features common to Windows-based and 
web-based navigators:

• DECT system connectivity

• DECT system connection control

• read data from a DECT system on demand

• define handsets with the overlays in the OTM database

• define handsets in the DECT database

• subscribe handsets
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Maintenance features
The following are maintenance features common to Windows-based and 
web-based navigators:

• operational status monitoring

• alarm management

• date and time

• Upstream Manager IP address

• basic browser

• DECT system data synchronization with the DECT Manager database

• performance

• PC Event Log

Security features
For information about the Security features, see Using Optivity Telephony 
Manager (553-3001-330).

OTM server connections to DECT 
Figure 25 on page 71 shows an overview of an OTM server connected to a 
DECT system over a V.24 interface. 

Web clients access the OTM server over a LAN or WAN and over the Public 
Switched Telephone Network, using modems. For the OTM to communicate 
over PPP with the DECT system, configure Remote Access Service (RAS) 
for modem dial out. See “Access the DECT application with a web-based 
navigator” on page 140. For more information about OTM access, see Using 
Optivity Telephony Manager (553-3001-330).

A client, in this context, is a DECT application that runs on a personal 
computer or workstation, and depends on an OTM server to perform some 
operations. For example, a DECT application client is an application that 
enables personnel to manage a DECT system.

Figure 26 on page 72 shows an overview of an OTM server connected to a 
DECT system, over a dedicated LAN interface.
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Remote Access Service (RAS)
A computer in a network provides access to remote users through analog 
modem or ISDN connections. It includes the dial-up protocols and access 
control (authentication), and can be a regular file server with remote access 
software or a proprietary system. The modems can be internal or external to 
the device.

ISDN is an international telecommunications standard for providing a digital 
service from the customer's premises to the dial-up telephone network.

Figure 25
Local OTM server access to a DECT system by V.24
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Figure 26
Local OTM server access to a DECT system by dedicated LAN
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Access the DECT application with a Windows-based 
navigator

For access from a web-based navigator, see the section “Access the DECT 
application with a web-based navigator” on page 140.

Login to the OTM

Figure 27
OTM login dialog box

Access the OTM Login dialog box using the Start menu, under Programs, 
OTM. The login dialog appears as shown in Figure 27. After entering a User 
ID and Password, the OTM Windows Navigator window appears, as shown 
in Figure 28.

Note: See Using Optivity Telephony Manager (553-3001-330) for 
details about the OTM login dialog box.
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Select the Meridian 1 PBX that supports the DECT system

Figure 28
OTM Navigator window

In the OTM Navigator window, select the Meridian 1 system that supports the 
DECT system to be administered. Double-click on the Meridian 1 system 
(shown as Sample Site in Figure 28), and the M1 System Window appears. 
See Figure 29 on page 75.

Note: See Using Optivity Telephony Manager (553-3001-330) for 
details about the OTM Navigator window.
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Open DECT Application

Figure 29
M 1 System Window

Open the DECT application by double clicking on DECT (shown in Figure 
29), or open through the File menu. This action displays the DECT System 
window, shown in Figure 30 on page 76.
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DECT Systems window

Figure 30
DECT Systems window

Use the DECT Systems window to enable the following features:

• select a DECT system to view database details, or select all DECT 
systems to view database details.

List filter

List

Connection status

Operation progress
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• add a DECT system

• delete a DECT system

• connect to, disconnect from, lock or unlock a connection between the 
OTM server and a DECT system. See “Connecting to a DECT system” 
on page 80.

• open the following windows for the selected DECT systems

— Subscriptions

— DMC Boards

— Base station Radio Fixed Parts

— Active Alarm Snapshot

— Performance Collection

— Current RSSI data

Menu options
The DECT Systems window displays the following:

• File – contains a pull-down menu that allows one of the following to be 
selected:

— Add – creates a new DECT system with default values and opens the 
DECT System Properties window

— Delete – removes a DECT system from the OTM server/OTM client

— Connect / Lock / Disconnect – the same functions as the 
Connect/Disconnect tool. See “Connecting to a DECT system” on 
page 80.

— Properties – opens the DECT System Properties window (Figure 38 
to Figure 49)

— Close – closes the client application and all DECT windows opened 
by that client
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• View – contains a pull-down menu that allows the following bars to be 
shown or hidden:

— Tool bar

— Status bar

• Applications – contains a pull-down menu that allows the following 
windows to be opened:

— Subscriptions (Figure 55 on page 103)

— Boards (DMC) (Figure 69 on page 124)

— Radios (base stations) (Figure 71 on page 128)

— Current Alarms 

— Performance Collection (Figure 75 on page 136)

— Current RSSI data (Figure 77 on page 139)

• Firmware – contains a pull-down menu that allows the following 
windows to be opened:

— Upload – loads firmware to DMC (Figure 50)

— Activation – makes firmware active 

• Help – contains a pull-down menu used to select the following:

— Content and Index

— About OTM DECT Management application

• Tool bar icon – used to click a tool button to do the following:

—  – opens a connection to a DECT system selected in the List, 
when the Connection status shows Disconnected. When opened, the 
icon turns red. See “Connecting to a DECT system” on page 80.

—  – locks the connection to a DECT system when the Connection 
status is Connected. This prevents another user from closing the 
connection.
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—  – disconnects from a DECT system when the Connection status 
is Connected

—  – unlocks the connection from a DECT system when the 
Connection status is Connected/Locked

Note: While the Connection status is Connecting or Disconnecting, the 
Connect/Disconnect tool is disabled. The status bar shows the 
connection progress.

• List filter – select one of the following:

— This Meridian only – lists the DECT System data selected from the 
M1 System Window. See Figure 29 on page 75.

— All DECT Systems – lists every DECT Systems data managed by 
the OTM server

• List field – shows the following for the DECT system or systems 
selected from the M 1 System Window (Figure 29 on page 75):

— site name/location (Figure 38 on page 76)

— Meridian 1 PBX name (Figure 38)

— DECT system name (Figure 38)

— presence of an alarm (Figure 48 on page 97)

— IP address, for the DECT system (Figure 44 on page 93)

— Primary Access Rights Identifier (Figure 46 on page 95)

— Concentration mode (Figure 38)

— number of subscribed handsets (Figure 38)

— connection status

• Connection status field – shows the current state of the connection, 
where:
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— Disconnected – indicates no communication between the OTM 
server and a DECT system.

— Connected – indicates communication between the OTM server and 
a DECT system for an operation initiated by a user. The connection 
disconnects when the operation is finished.

• Operation progress field – shows the last received event associated 
with the connection, such as the following:

— Disconnecting

— Connecting

— Modem Busy

— Dialing

Additional information
Connecting to a DECT system
When the first connection to a new, installed DECT system is opened, the 
OTM DECT Application retrieves the DMC configuration from the OTM 
database. The OTM DECT Application reads the parameters from the DECT 
system for the manager database.

Perform one of the following actions to open a connection to a DECT system 
from an OTM DECT Application:

• Check the Permanent Connection box, allowing the connection to open 
when the OTM server starts. See Figure 42 on page 91.

• Select a DECT system in the list and click the Connect icon.

• Select an action on the menu bar that requires a system connection. For 
example, when Firmware > Upload is chosen, the connection opens to 
carry out the upload and then closes. 

Note: Do not use this type of connection for subscription actions. When 
using this type, the subscription status is not refreshed when an on-air 
subscription or de-subscription occurs.

The status bar of the application provides progress feedback while the 
connection opens.
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Synchronization when the DECT Application connects to a DECT 
system
When the DECT manager connects to the DECT system, synchronization 
occurs. Synchronization compares the database on the manager to that of the 
DECT system. Database mismatches are flagged by dialogs. The opportunity 
is then given to change either the DECT system data or manager data.

A number of synchronization steps occur during connection. The 
Synchronization process flags changes made to a DECT system database by 
other managers.

Two types of synchronization occur when the connection state goes from 
Disconnected to Connected:

• when the File menu or tool button is used to connect. The 
synchronization can be controlled through dialogs.

• when the OTM re-establishes a permanent connection to the DECT 
system. A synchronization report is available in the Event log on the 
OTM server.

When connecting to a DECT system that has data that does not match the 
OTM DECT Application data, do one of the following:

• Update the OTM DECT Application database from the DECT system 
data

• Update the DECT system data with the OTM DECT Application 
database
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Figure 31
Synchronize DECT PARI and SARI Mismatch dialog

If there is a PARI or SARI mismatch between the OTM DECT Application 
database, and the DECT system database, the mismatch dialog enables the 
update of PARI and SARI parameters on both the connected DECT system 
and the OTM DECT Application. See Figure 31.
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Figure 32
Synchronize DECT Parameters Mismatch dialog

If there is a Parameter mismatch between the OTM DECT Application 
database, and the DECT system database, the mismatch dialog enables the 
update of Parameters on both the connected DECT system and the OTM 
DECT Application. See Figure 32.
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Figure 33
Synchronize DECT Board Configuration Mismatch dialog

Figure 33 shows DMC TNs (Boards) listed in the OTM DECT Application 
database that are not operational on the DECT system. Delete the check in the 
check boxes. This allows the DMCs that are no longer required in the OTM 
DECT Application database to be removed.
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Figure 34
Synchronize DECT Radio Fixed Part Configuration Mismatch dialog

Figure 34 shows Radio Fixed Parts (base stations) listed in the OTM DECT 
Application database that are not operational on the DECT system. Delete the 
check in the check boxes. This allows the base stations no longer required in 
the OTM DECT Application database to be removed.
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Figure 35
Synchronize Radio Fixed Part Settings Mismatch dialog

A Power Source/Alarm Muting setting was changed by another manager. 
Figure 35 says that the OTM DECT Application database automatically 
updates to match the changed settings.

Figure 36
Synchronize DECT Upstream Manager IP Address Mismatch dialog

If there is an Upstream Manager IP address mismatch between the OTM 
DECT Application database and the DECT system database, the mismatch 
dialog enables an update of the Upstream Manager IP address on both the 
connected DECT system and the OTM DECT Application. See Figure 36.
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Figure 37
DECT Subscription Configuration Mismatch dialog

The dialog warns of a DMC mismatch between the DECT system and the 
OTM server database. The manager cannot automatically solve the 
mismatch. The mismatch must be solved manually.

 

DECT System Properties dialog
The DECT System Properties dialog is selected from the File menu.The 
DECT System Properties window has five tabs:

• General

• Communication

• Access Right Identification

• Alarm

• Parameters

See Figure 38 on page 88.
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DECT System Properties dialog – General tab

Figure 38
DECT System Properties – General tab

The General tab enables the following options:

• View the site name.

• View the Meridian 1 PBX name.

• View or change the DECT System name (Figure 39 on page 89 and 
Figure 40 on page 89).

• Change the password (Figure 41 on page 90).

• View if Concentration mode is active or not active.

• View the number of subscribed handsets.
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The DECT System Name Missing window appears when a DECT System 
name is not entered. See Figure 39.

Figure 39
DECT System Name Missing dialog

The application will not save a system unless a unique name has been 
provided.

The DECT System Name Already in Use window appears when a DECT 
System name is the same as the name of another system. See Figure 40.

Figure 40
DECT System Name Already in Use dialog

The Change DECT System Password window is selected from the DECT 
System Properties – General tab. See Figure 41.
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Figure 41
Change DECT System Password dialog

If the new password does not match the confirmed password, a dialog box 
opens and warns that the passwords do not match and allows the passwords 
to be changed.

DECT System Properties dialog – Communication tab
The DECT System Properties dialog is selected from the File menu. See 
Figure 42 on page 91.
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Figure 42
DECT System Properties – Communication tab

The Communication tab enables the following features:

• View or change the unique IP address; used if the connection is Serial or 
Ethernet.

• View the Subnetwork Mask.

• View the Gateway IP address.

• Check a Permanent Connection to keep the connection open and open the 
connection when the OTM starts.
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• Select Close Connection (see Figure 43 on page 92)

• Select Ethernet or Serial connection

• Select Details for the Serial connection (see Figure 44 on page 93)

• Select a new DECT system definition by pressing the OK button. This 
causes the manager to try to connect to a new DECT system and write the 
system name in MIB2, after the following is done:

— Enter the new system IP address.

— Specify the new system name.

The Close Connection dialog opens when the Close Connection button on 
the DECT System Properties – Communication tab is clicked. See Figure 43.

Figure 43
Close Connection dialog
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DECT System Detailed Connection settings properties is selected from 
the Details button of the DECT System Properties – Communication tab. 
See Figure 44.

Figure 44
DECT System Detailed Connection settings properties

DECT System Detailed Connection settings properties enables the 
following options:

• View or change the OTM Server IP interface assigned to the PC RAS 
port interface on the same network as the DECT system.
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• View or select the COM Port attached to either the DECT system or the 
modem.

• Select a modem mode.

• View or change the Phone Number that dials the modem.

Figure 45
Local and remote IP address for serial connections

Supply an IP address for local and remote ends of the serial link, so the OTM 
can route IP traffic to the correct DECT system. See Figure 45.

DECT System 1

DECT System n

OTM Server

Serial links

IP at DECT System 1 remote

IP at DECT System n remote

IP at DECT System n local

IP at DECT System 1 local
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DECT System Properties dialog – Access Right Identification tab
The DECT System Properties dialog is selected from the File menu. See 
Figure 46.

Figure 46
DECT System Properties – Access Right Identification tab

There are two Access Right Identifications, a Primary Access Right 
Identification (PARI) and a Secondary Access Right Identification (SARI), 
which identify each DECT system. The Access Right Identification enables 
the following:

• View or change the PARI. See Figure 47 on page 96.

• View or change the SARI. (A SARI dialog box is similar to that shown 
in Figure 47.)
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The Change DECT System PARI window appears when the Change 
PARI... button on the Access Right Identification tab is pressed. See 
Figure 47.

Figure 47
Change PARI dialog

Do not change the PARI or SARI until connected to the DECT system 
requiring the new PARI or SARI.

During synchronization, a dialog warns if a DECT system has a different 
PARI or SARI than the OTM DECT manager. 

See “Multi Site Mobility Networking subscriptions” on page 118 for 
additional information about changing the PARI and SARI.
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DECT System Properties dialog – Alarm tab
The DECT System Properties dialog is selected from the File menu. See 
Figure 48.

Figure 48
DECT System Properties – Alarm tab

The Alarm enables the following options:

• View a Yes or NO in the active alarm when the manager is connected to 
a DECT system with an active alarm.

• View or change the Upstream Manager IP address. The DECT system 
can send alarms to an upstream manager.

• View or change the Date and Time, used to timestamp alarms. When not 
connected, the Date and Time fields are blank. When the DECT system 
is reset, the time and date are not updated.
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DECT System Properties dialog – Parameters tab
The DECT System Properties dialog is selected from the File menu. See 
Figure 49.

Figure 49
DECT System Properties – Parameters tab

The Parameters tab enables the following options:

• View or change Tone Duration in milliseconds.

• View or change Inter Digit Pulse width in milliseconds.

• View or change Level 1 - low frequency in decibels.
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• View or change Level 2 - low frequency in decibels.

• View or change Analog/Digital loss pad- handset to system in decibels.

• View or change Analog/Digital loss pad- system to handset in decibels.

• Set all parameters to Factory Default values.

The DECT System Properties Parameters are read from the DECT system on 
synchronization. 

Firmware upload and activation
The Firmware upload dialog is selected from the Firmware menu.

Figure 50
Firmware upload with DMC-4 dialog

The designator DMC is used to differentiate between the NTCW00AA DMC 
card and the NTCW00AB DMC8 card. 

WARNING
System Failure

Do not use the Advanced.... button. It can cause the 
system to fail.
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This dialog alerts that a DMC card cannot support a firmware upload. If OK 
is selected, a file chooser allows a firmware file to be selected from the Client 
or from the OTM server. See Figure 52 on page 101. When OK is selected, 
the existing standby firmware can be replaced with new firmware.

Do one of the following:

• Accept the firmware for the DECT system.

• Cancel the firmware upload for the DECT system.

See Figure 50 on page 99.

Figure 51
Firmware upload dialog
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Figure 52
Firmware activation dialog

Figure 53
Upload file chooser
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The Upload radio buttons enable the following options:

• Browse files on the Client PC.

• Browse files on the OTM Server.

Select a file from either the client or the server to upload to the DECT system.

Figure 54
Progress indicator
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Subscriptions window
The Subscriptions window is selected from the DECT Systems window 
Applications menu. See Figure 55.

Figure 55
Subscriptions window
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Features
The Subscriptions window enables the following:

• Connect to, disconnect from, lock or unlock a connection between the 
OTM server and a DECT system.

• Choose to show, in any combination, (see Figure 57 on page 109 and 
Figure 58 on page 110) handsets that are:

— Available

— Subscribed

— Enabled

— Blacklisted

— configured on one DMC8 or all DMC8s

• Subscribe (configure) handsets.

• De-subscribe handsets.

• Copy subscription data.

• Move subscription data.

• Delete subscription data.

• Find subscription data.

• Export subscription data.

• Import subscription data.

Note: To use a handset, the handset must first be programmed on the 
Meridian 1 PBX using LD 10.

Menu options
The Subscriptions window displays the following:

• File – contains a pull-down menu allowing one of the following to be 
selected:

— Import – a subscription from a file (see Figure 61 on page 114)

— Export – a subscription to a file (see Figure 62 on page 115)
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— Connect – Lock, Unlock, Disconnect

— Properties – includes data in the subscription list and International 
Portable User Identifier (IPUI) (see Figure 68 on page 122)

— Close – close the Subscriptions window

• View – contains a pull-down menu that shows or hides the following:

— Tool bar

— Status bar

• Edit – contains a pull-down menu to open the following dialog boxes:

— Copy (see Figure 59 on page 112)

— Delete (see Figure 58 on page 110)

— Find (see Figure 63 on page 116)

• Operations – contains a pull-down menu to open the following 
windows:

— Configure – to program a handset on the Meridian 1 system. See 
Figure 56 on page 108.

— Set Default PARK – enter the default Portable Access Rights Key. 
See Figure 65 on.)

— Enable – to subscribe a handset

— Disable – to de-subscribe a handset from one DECT system (see 
Figure 66 on page 120) or de-subscribe a handset from all DECT 
systems, for example, Multi Site Mobility Networking. See the 
section “Multi Site Mobility Networking subscriptions” on 
page 118.

— Force Disable – to return the subscription to the available state, and 
requests the system to disable the subscription. However, there is no 
interaction between the system and handset. See Figure 67 on 
page 121.
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— Retrieve OTM Configuration – to retrieve the Meridian 1 handset 
configuration from the OTM Station Administration database. If 
there is a mismatch between the Station Administration 
configuration and the DECT application configuration, see Figure 
64 on page 117.

• Help – contains a pull-down menu to select the following:

— Content and Index

— About DECT application

• Tool bar – click the appropriate tool button to do the following:

—  connect,  lock,  unlock,  disconnect – performs the 
same functions as the “DECT Systems window” on page 76

—  enable – to subscribe a handset

—  disable – to de-subscribe a handset 

—  configure – to program a handset

• List filter – to show or hide details of handsets that are:

— available (see Figure 57 on page 109 and Figure 58 on page 110)

— subscribed (Figure 57 and Figure 58)

— enabled (Figure 57 and Figure 58)

— black-listed (Figure 57 and Figure 58)

Note: DMC restricts the list to subscription data for one DMC or lists 
subscription data for all DMC 

• List – to show the following subscription details for handsets assigned to 
a <sitename>, a <PBX name>, a <DECT system name>. See the Figure 
55 title bar on page 103.

— DMC TN

— index – 32 units or 510 virtual units for concentration on a DMC
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— concentrated handset Home DN

— concentrated handset Local DN – different than Home DN for 
visitor concentrated handset

— virtual TN for concentration handsets

— subscription PARK

— subscription status – updated by SNMP traps from the DECT system

— PIN code appears during subscription activation

— an 80-character comment

• Pop up menu – available when at least one subscription is selected. The 
pop-up menu contains the following items:

— Configure

— Enable

— Disable

— Copy

— Move

— Delete

— Export

— Properties

— Help

• Status bar – shows the following:

— connection status

— operation status

— current subscription PARK
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Configure and enable a subscription

Figure 56
Configure DECT Subscription dialog

Configure DECT Subscription enables the following:

• Select a DMC TN.

• Enter the first subscription index (unit, as in l s c u).

• Select a number of consecutive subscriptions.

See Figure 56.

When configured, the subscription becomes available and the subscription 
can be enabled. During the enable process, the DECT manager generates a 
PIN code for the subscription. See Figure 57 on page 109.
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Figure 57
Enable a subscription

Disable subscriptions
A subscription can be de-subscribed in the following ways:

• as a single handset 

• in a list of selected handsets

• for all handsets on a DMC

Available

Enabled

Subscribed

PIN
code

entered within
15 minutes

?

No

Yes

DECT channel is configured
and available for subscription.

The subscription process starts with the user selecting
the handset(s) and pulling down the Operations menu
then clicking on Enable

The handset is now ready to make and receive calls

The OTM DECT manager provides a PIN
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Figure 58
Disable a subscription

Launching an on-air de-subscription requires an open connection to the 
DECT system.

When the DECT Manager starts the de-subscription, the DECT system holds 
the de-subscription until one of the following occurs:

• The handset makes or receives a call.

• The DECT Manager removes the subscription.

The DECT system notifies the DECT Manager that the handset is 
de-subscribed.

The DECT manager can stop a handset from operating on all the DECT 
systems where the handset is subscribed with a given International Portable 
User Identifier (IPUI).

Available

Black listed

Subscribed

The de-subscription process starts with the user 
selecting the handset(s) and pulling down the 
Operations menu, then clicking on Disable

The handset can make and receive calls

The following conditions must exist:
- connection with the system
- handset in range
- handset on
- handset go off-hook or called 

Handset ready for subscription
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To stop a handset from operating, the handset must be within radio range and 
ready for on-air de-subscription. The process removes handset subscription 
data from the following:

• the DECT system DMCs

• the handset

• the DECT managers handset and DECT system files

When the handset’s subscription data is removed, the handset no longer 
works on any DECT system.

Delete subscriptions
The Delete operation allows handset information to be removed from the 
manager and the DECT system, but not the handset. The Delete operation 
does not require the handset to be available for on-air de-subscription. The 
Delete operation does the following:

• removes the DECT system handset subscription data

• retains the handsets subscription data, if the handset had subscription 
data. (As the handset does not remove its subscription data, it continues 
operating on all the DECT systems where this subscription is relevant.)

• removes the DECT manager handsets subscription data including 
comments and Meridian 1 PBX Station Administration data

The DECT Manager can be used to remove subscription records from the 
following:

• a single handset subscription

• a list of selected subscriptions

• a DMC or from all DMCs at once

The subscription removal requires an open connection to the DECT system.

Remove subscription records for the following reasons:

• to clean a Multi Site Mobility Networking DECT system subscriptions 
on the distributors premises

• to move a DMC from one DECT system to another
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Copy subscriptions
The DECT Copy Subscription dialog is selected from the Edit menu.

Figure 59
DECT Copy Subscription dialog

The DECT Copy Subscription dialog allows subscriptions to be copied 
from a DMC on DECT system A and then pasted into a DMC on DECT 
system B. The subscriptions must have a Subscribed status.

Ensure the connection to the destination system is open. Select the 
Destination DECT system and the Destination DMC from the DECT Copy 
Subscription dialog.

Subscriptions can be copied from the following:

• a single handset subscription

• a list of selected subscriptions

• a DMC
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Note: Subscriptions cannot be copied within the same DECT system. 
When a subscription is copied, only the DECT system data is copied, not 
the Meridian 1 PBX data.

In Figure 59 on page 112, the source subscription data appears in the three left 
columns; DMC TN, Index, and Local DN. View the source subscription from 
the Subscription window. The destination subscription data is in columns 
To: DMC TN, and To: Index. Index is the Unit on the DMC. When the 
dialog opens, the source DMCs and destination DMCs are the same.

When copying subscription data, ensure a connection exists between the 
source DECT system and the destination DECT system.

The Copy Subscription feature provides a way to support Multi-site Mobility 
Networking, by allowing handsets to be subscribed without being on the 
Distributor Premises.

The Replace DECT Subscription dialog allows an action to be confirmed if 
more than one subscription will be overwritten at the destination. See 
Figure 60.

Figure 60
Replace DECT Subscription dialog
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Move Subscriptions
The Move Subscriptions dialog is selected from the Edit menu.

Move Subscriptions is similar to Copy, except for the following. The Move 
Subscriptions dialog allows subscriptions to be cut/removed from a DMC on 
DECT system A, and the subscriptions pasted into a DMC on the same DECT 
system, or on DECT system B. 

When using Move, the source DECT system and the destination DECT 
system must be connected.

Import Subscriptions
The DECT Import Subscriptions dialog is selected from the File menu. See 
Figure 61.

Figure 61
DECT Import Subscription dialog

Import Subscriptions is similar to Copy, except for the following. The import 
dialog allows subscriptions to be copied from an import file and the 
subscriptions pasted into a DMC on a DECT system. 

To paste a subscription, ensure a connection to the destination DECT system.
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Export DECT Subscriptions
The Export DECT Subscriptions dialog is selected from the File menu.

Figure 62
Export Subscription dialog

Export Subscriptions is similar to Copy, except for the following. The export 
dialog copies subscriptions from a DECT system and pastes them into a file. 
See Figure 62.

Note: Import and Export support Multi Site Mobility Networking and 
Subscription on the Distributor Premises to a DECT system normally 
managed by OTM “B”, not OTM “A”.

Find DECT Subscriptions
The Find DECT Subscriptions dialog is selected from the Edit menu.

The Find operation allows subscription information to be located by 
searching for an IPUI or a Home DN, using the Find DECT Subscription 
dialog. See Figure 63 on page 116.

The Find action displays the subscription information in the Find DECT 
Subscription Result dialog box.
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Figure 63
Find Subscription dialog

Synchronize DECT and Station Administration
Configuration

The Synchronize DECT and Station Administration Configuration 
dialog is selected from the Operations menu (Retrieve OTM Configuration) 
if there is a mismatch. If there is no mismatch, synchronization occurs and 
Figure 64 on page 117 does not appear.
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Figure 64
Synchronize DECT and Station Administration Configuration Mismatch

DECT systems support configured and subscribed handsets as TNs. The 
Meridian 1 PBXs have matching TN handsets configured in LD 10.

Meridian PBX to DECT system synchronization
If the Meridian PBX configuration data is available through the OTM Station 
Administration database, then a synchronization facility is available to import 
the data into the DECT manager. Synchronization is subject to the following 
rules:

• A handset not listed in the DECT Manager, but present in the OTM 
database, is added in the DECT Manager list.

• If the DECT Manager lists a handset, but the OTM database does not, the 
DECT Manager prompts to either keep or remove the handset.

To add handsets to the DECT manager, select Configure from the 
Operations menu. See “Synchronize DECT and Station Administration 
Configuration” on page 116.

The Synchronize DECT and Station Administration Mismatch dialog box 
highlights DMC TNs in the DECT manager that are not configured in the 
OTM Station Administration. Those subscriptions must be kept in the DECT 
manager so they can be checked. See Figure 64 on page 117.
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If there is no mismatch that OTM cannot resolve automatically, the 
Synchronize DECT and Station Administration dialog does not appear. 

Two examples of mismatches that OTM cannot resolve automatically are as 
follows:

• There are no entries in the Station Administration database, or 

• the DECT Manager does not have a DMC configured in a Meridian 1 
PBX TN location, but an entry exists in the Station Administration 
database.

Multi-site Mobility Networking subscriptions
In Multi-site Mobility Networking (MSMN), users can take their DECT 
handsets to other sites in the network, and make and receive calls as if they 
were at their home location. A handset is subscribed in a given DECT system 
and can be used in one or many DECT systems. 

For information on MSMN feature description, feature interaction, feature 
packaging, and operating parameters, see “Multi-Site Mobility Networking” 
on page 147. For information on MSMN feature implementation and 
operation, refer to “Multi-site Mobility Networking” in DECT Installation 
Guide (553-3601-203).

Every handset has a Portable Access Rights Key (PARK). Every DECT 
system has a Primary Access Rights Identifier (PARI), and can have a 
Secondary Access Rights Identifier (SARI).

The handset PARK and DECT system PARI and SARI are used by the 
handset and DECT system to identify each other. The PARK and PARI/SARI 
match allow the handset to work with a DECT system.

In an MSMN network, for example, DECT system “A” has a PARI matching 
a handset PARK while DECT systems “B”, “C”, and “D” have a SARI 
matching the handset PARK.

The DECT Manager user programs the SARI in the DECT system. The 
DECT Manager provides the PARK during the on-air subscription, and the 
PARK is programed into the handset at subscription time. See Figure 46 on 
page 95 and Figure 47 on page 96.
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For example, a handset can be subscribed to a DECT system on a distributor’s 
premises, where the handset is not to be in operation. Then the subscription 
data is downloaded to a DECT system where the handset is to be in operation. 
The PARI of the DECT system where the handset is subscribed and the SARI 
of the DECT system where the handset is used are not always the same. The 
PARK matching the destination DECT system to the handset is provided 
during the on-air subscription.

Figure 65
DECT Default Subscription PARK dialog

The DECT Manager provides the ability to specify the PARK given to the 
handset, to support Multi Site Mobility Networking and Subscription on the 
distributor premises. See Figure 47 on page 96. The PARK normally defaults 
to the PARI of the system where the on-air subscription occurs. For MSMN, 
the default PARK must be equal to the network SARI value for any 
subscription activity to take place.

The PARK used by the OTM DECT subscription application is subject to the 
following conditions:

• PARK is limited to the lifetime of the subscription application.

• Two users can use a different PARK on the same DECT system at the 
same time.

• PARK is not recorded in persistent storage.
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Disable DECT Subscriptions
The Disable DECT Subscriptions dialog is selected from the Operations 
menu.

Figure 66
Disable DECT Subscription dialog

Use the Disable DECT Subscriptions window to disable a handset from all 
DECT systems used in Multi Site Mobility Networking systems. See Figure 
66.

Use from this system only or if the handset is on-air on this DECT system. 
This DECT system contacts the handset. When contact is established, the 
subscription is removed from the handset. The subscription is removed from 
both the system database and the OTM server database. The other DECT 
systems remove subscription data in the background, and the OTM server 
updates its database for these systems.

If from all systems where the portable set is subscribed is used, all DECT 
systems are asked to contact the handset. The first DECT system to contact 
the handset removes the handset’s subscription. The subscription is removed 
from the first DECT system database, and the OTM server database. The 
other DECT systems remove subscription data in the background and the 
OTM server updates its database for these systems.
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Force disable DECT Subscription 
The Force disable DECT Subscriptions dialog is selected from the 
Operations menu.

Figure 67
Force disable DECT Subscription dialog

Force disable returns the subscription to the available state and requests the 
system to disable the subscription. However, there is no interaction between 
the system and handset.

Force disable can be used when the handset is not in range or on-air.

Select on this DECT System only or to remove the handset subscription 
from only this DECT system and remove the handset subscription from all 
other DECT systems in the background. See Figure 67.

Select on all DECT Systems where it is present? to remove the handset 
subscription from all systems at the same time. See Figure 67.
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DECT Subscription Properties
The DECT Subscription Properties sheet is selected from the File menu. 
The DECT Subscription Properties sheet is shown in Figure 68.

Figure 68
DECT Subscription Properties

Features
The DECT Subscription properties sheet enables the following:

• View the DMC Terminal Number.

• View the Index. Index is the TN unit, as programmed in LD 10 in a 
non-concentrated system, and a virtual TN unit in a concentrated system.

• Change and apply Comments, up to 80 characters.
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• View Home Directory Number (where the handset is configured on the 
Meridian PBX as the home location).

• View Local Directory Number.

• View Home handset only.

• View handset Virtual Terminal Number.

• View the International Portable User Identifier (IPUI).

• View the subscription PARK.

• View the subscription status.

• View the subscription PIN.

DECT Subscription Properties sheet definition
The Subscription properties sheet displays the same subscription data as the 
Subscriptions window list items. 
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DMC boards window
The DMC Boards window, seen inFigure 69, is selected from the DECT 
Systems window Applications menu, seen in Figure 30 on page 76.

Figure 69
DMC Boards window
553-3601-103 Standard 5.00 September 2002



Optivity Telephony Manager for DECT systems Page 125 of 164
Features
The Boards (DMC) window enables the following options:

• Examine DMC details.

• Connect to, disconnect from, lock or unlock a connection between the 
OTM manager and a DECT system.

• Show Operational DMC, Non-operational DMC, or both.

• Open a properties sheet.

DMC Boards window definition
The Boards window displays the following DMC data: 

• File – contains a pull-down menu to select one of the following:

— Clear – erases all subscriptions, sets all base stations to installed 
status and line powered, allows the DMC to be programmed in a new 
DECT system

— Connect – Lock, Unlock, Disconnect, works the same as the 
Connect/Disconnect tool

— Properties – see Figure 70 on page 127

— Close – closes the DMC window

• View – contains a pull-down menu to show or hide the following:

— Tool bar

— Status bar

• Synchronization – contains a pull-down menu to enable the following:

— Synchronize From – subscription and base station alarm 
muting/power source configuration data from a DMC to the OTM 
server 

— Synchronize To – subscription and base station alarm muting/power 
source configuration data from the OTM server to a DMC
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• Help – contains a pull-down menu to select the following:

— Content and Index

— About DECT application

• Tool bar – click the tool button to  connect,  lock,  unlock, 

 disconnect

• List filter – to show list details of only the operational DMC or non- 
operational DMC or both

• List – shows the following DMC details:

— DMC TN

— DMC type

— relay DMC

— operational state – when DMC operational status changes, the OTM 
server updates the status

— Number of handsets on a DMC

— an 80-character comment

• Pop up menu – supports the following actions:

— Synchronize from DMC

— Synchronize to DMC

— Properties

— Help

• Properties – displays additional information about DMC. Only the 
comment can be modified. See Figure 70 on page 127.
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DECT Board properties sheet
The DECT Board properties sheet (see Figure 70) is selected from the File 
menu.

Figure 70
Board (DMC) properties sheet

Options
The DECT Board properties sheet enables the following options:

• View DMC details.

• View operational status. When the DMC operational status changes on 
the DECT system, the OTM updates the status.

• Change and apply comments, up to 80 characters.

• View DMC Type Number.

• View DMC Manufacture Code.
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• View DMC Standby Software Package.

• View DMC Boot Package.

• View DMC Protocol Version.

• Open the help file.

• Close the properties sheet.

Radio Fixed Part (base station) window 
The Radio Fixed Part (RFP) window (see Figure 71) is selected from the 
DECT Systems window Applications menu. See Figure 30.

Figure 71
RFP (base station) window
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The RFP window enables the following:

• Examine base station details.

• Connect to, disconnect from, lock or unlock a connection between the 
OTM server and a DECT system.

• Choose to show Muted base stations, or Not Muted base stations, or both.

• Cancel mute  allows a base station to generate alarm messages. Mute 
 keeps a base station from generating alarm messages.

• Open a properties sheet.

The RFP window displays the following base station data: 

• File – contains a pull-down menu to select one of the following:

— Connect / Lock / Unlock / Disconnect, works the same as the 
Connect/Disconnect tool

— Properties, opens the Radio Fixed Part properties sheet

— Close, closes the Radio Fixed Part window

• View – contains a pull-down menu to show or hide the following:

— Tool bar

— Status bar

• Edit – contains a pull-down menu to do the following:

— Mute Alarms – keeps a selected base station from generating alarms

— Cancel Mute Alarms – allows a selected base station to generate 
alarms

Note: View alarms on the OTM Alarm browsers (common services) or 
on the Active Alarm Snapshot window. See Figure 73 on page 132.

• Help – contains a pull-down menu to select the following:

— Content and Index

— About DECT application

• Tool bar icon – click the tool button to do the following:
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—  connect,  lock,  unlock,  disconnect

—  Mute Alarms – keeps a selected base station from generating 
alarms

—  Cancel Mute Alarms – allows a selected base station to 
generate alarms

• List filter – to select a list showing base stations allowed to generate 
alarms, or base stations not allowed to generate alarms, or both

• List – displays the following:

— DMC TN – connected to a base station

— Radio Identifier – identifies the base station (1 to 4) connected to the 
DMC and the base station (1 to 8) connected to the DMC8

— Operational State – indicates if a base station is operational or is not 
operational

— Alarm Muted – indicates if a base station is allowed to generate 
alarms or not

— Number of Channels – identifies the base station as either a 
6-channel or a 12-channel base station

— Comment – an 80-character comment field in the DECT application 

• Pop-up menu – appears when at least one base station, also known as a 
Radio Fixed Part (RFP), is selected and right-clicked. Selecting one or 
more base stations by clicking/double-clicking on a Radio Identifier, or 
highlighting a row in the list, displays a Properties sheet. See Figure 72 
on page 131.

• Help – select Content and Index or About DECT application
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DECT Radio Fixed Parts (base station) properties sheet 
The DECT Radio Fixed Parts properties sheet is selected from the pop-up 
menu.

Figure 72
Radio Fixed Part (base station) properties sheet

The DECT Radio Fixed Parts properties sheet options
The RFP properties sheet enables the following:

• View base station details.

• View Operational Status. When the base station operational status 
changes, the OTM server updates the status.

• Change and apply Alarm Muting.

• Change and apply comments – up to 80 characters.

• Select Line Power (powered by the DMC card) or Local Powered.
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• Open the help file.

• Close the properties sheet.

RFP properties sheet definition
The Radio Fixed Part properties sheet displays the same base station data as 
the Radio Fixed Part window list items. The properties sheet also shows the 
power source for the selected base station. 

Active Alarm Snapshot window
The Active Alarm Snapshot window is selected from the DECT Systems 
window Applications menu.

Figure 73
Active Alarm Snapshot window

Features
The Active Alarm Snapshot window enables the following:

• Connect to the Active Alarm Snapshot window.
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• Refresh the window.

• Open a properties sheet.

Menu options
The Active Alarm Snapshot window displays the alarm data stored in the 
DMC. The alarm data displayed does not change or update until manually 
refreshed.

• File – contains a pull-down menu to select one of the following:

— Connect / Lock / Unlock / Disconnect – the same functions as the 
Connect/Disconnect tool

— Properties – opens the Active Alarm Snapshot, Figure 74

— Close – closes the Active Alarm Snapshot window

• View – contains a pull-down menu to select the following:

— Tool bar – to show or hide

— Status bar – to show or hide

— Refresh – updates the Active Alarm Snapshot window with the latest 
alarm data from the DECT system selected in the title bar. A 
separate DMC TN cannot be selected to refresh.

• Help – contains a pull-down menu to select the following:

— Content and Index

— About DECT application

• Tool bar – click the tool button to do the following:

—  connect,  lock,  unlock,  disconnect

—  Refresh – updates the Active Alarm Snapshot window with the 
latest alarm data from the DECT system selected in the title bar. A 
separate DMC TN cannot be selected to refresh.

• List – shows read-only data about the following:

— Severity – always labeled as Critical
DECT Overview



Page 134 of 164 Optivity Telephony Manager for DECT systems
— Error Code – a three digit code. Refer to the Meridian DECT 
Operation Administration and Maintenance NTP for the meaning of 
the Error Codes

— DMC TN – indicates the location of the card that originated the 
alarm

— Radio Identifier (base station identifier) – indicates the base station 
that is the source of an alarm

— Date and Time – when the alarm occurred

— Operator Data – describes the alarm and the faulty component, if 
applicable

• Pop-up menu – appears when at least one RFP (base station) is selected, 
and right clicked. The DECT Active Alarm Snapshot window opens. 
See Figure 74 on page 135

• Help – displays Content and Index, and About DECT application
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DECT Active Alarm Snapshot properties sheet
The DECT Active Alarm Snapshot properties sheet, shown in Figure 74, is 
selected from the pop-up menu.

Figure 74
Active alarm properties sheet

The Active Alarm Snapshot properties sheet properties sheet enables the 
following:

• View alarm (DECT system message) details.

• Close the properties sheet.

• Open the help file.

Active Alarm Snapshot properties sheet definition
The Active Alarm Snapshot properties sheet displays the same alarm data as 
the Active Alarm Snapshot window list items. 
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Performance Collection window
The Performance Collection window, as seen in Figure 75, is selected from 
the DECT Systems window Applications menu.

Figure 75
Performance Collection window
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Figure 76
Select location

The Performance Collection window enables the following:

• Start and stop User Performance Collection counters.

• Start and stop Equipment Performance Collection counters.

The Performance Collection window displays the following:

• Name – to select the directory to store the Performance Collection file. 

• User Performance Collection – collects counter data on handset user 
related activities. 

• Equipment Performance Collection – collects counter data on DMC 
related activities. 
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Performance Collection additional information
The OTM DECT Manager user starts and stops performance counter 
collection. Performance collection cannot be scheduled. The collection 
begins when it is manually started, and ceases when manually stopped.

The collection period can be set for 15 minutes, 30 minutes, one hour, or one 
day. The performance counters are on the DMCs. DMC TNs can be selected.

User (handset) data and Equipment (DECT system) data can be collected 
separately. User (handset) data and Equipment (DECT system) data 
collection periods can be set separately.

The OTM DECT Manager stores the performance files. Rebooting the OTM 
DECT Manager does not destroy the files. 

The back up and restore application on the OTM DECT Manager does not 
back up and restore the performance files.

Retrieve RSSI Snapshot window
The Retrieve Radio Signal Strength Indication (RSSI) Snapshot window, 
shown in Figure 77 on page 139, is selected from the DECT Systems window 
Applications menu.
553-3601-103 Standard 5.00 September 2002



Optivity Telephony Manager for DECT systems Page 139 of 164
Figure 77
Retrieve RSSI Snapshot window
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The Retrieve RSSI window enables the following:

• View Radio Signal Strength Indication details.

• Scroll and select a DMC card for RSSI information retrieval.

The Retrieve RSSI Snapshot window collects, on request, the RSSI for a 
selected DMC card.

Retrieve RSSI Snapshot attributes
The OTM server collects the RSSI as an ASCII file. The OTM server user 
must indicate where to store the RSSI file.

Access the DECT application with a web-based navigator
For more detailed information on web-based navigators, see Using Optivity 
Telephony Manager (553-3001-330).

Administrator Login
To open the OTM web Administrator login screen, seen in Figure 78 on page 
141, enter the URL http:otm_server_name or use the ip_ address, in either the 
Microsoft Internet Explorer web browser or the Netscape Navigator web 
browser.

To launch the Administrator Login, click on the applet launch logo. See 
Figure 78 on page 141.
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Figure 78
OTM web Administrator login
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Current Status
The Current Status screen appears after logging in through the Administrator 
Login screen. See Figure 79.

Figure 79
OTM web navigator current Status

The screen in Figure 79 displays the current status of:

• OTM software release version

• time and date of the last login

• OTM server applications

The Current Status screen allows web navigator access to the items listed on 
the left side of the screen.
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System navigator
To select the System navigator, click on System Navigator in the list on the 
left of the Current Status screen. See Figure 79 on page 142.

Figure 80
OTM web system navigator

The System navigator window opens, as seen in Figure 80.

Select a DECT system(s). From the grey box on the left of the System 
navigator window, select an application to be opened for that system. For 
example, select OTM DECT to open the DECT Systems window (see 
page 76). Select Alarms to open the Alarm browser window. See page 144.
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Alarm browser
The Alarm browser, seen in Figure 81, can be opened from the System 
navigator window in one of two ways:

• by clicking on System Alarms in the list on the left of the screen

• by selecting Alarms in the gray box on the right of the screen

Figure 81
OTM web system Alarm browser

The Alarm Browser enables the system alarms to be examined.
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Web Access security
To open the Web Access security screen, click on Web Navigator Access 
from the list on the left in the System Navigator window, as seen in Figure 80 
on page 143.

The Web Access security window opens. See Figure 82.

Figure 82
Web Access security

Group and individual access permissions can be changed by the Windows NT 
User Administrator. 
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Multi-site Mobility Networking
Contents

This section contains information on the following topics:

Operating parameters. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148

Feature interactions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
Call forward from a MADN handset. .. . . . . . . . . . . . . . . . . . . . . 148
Card audit. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
Network Message Service. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

Feature packaging. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

Installation and operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

Reference list
The following are the references in this section:

• DECT Installation Guide (553-3601-203)

Introduction
Multi-site Mobility Networking (MSMN) allows a Meridian DECT handset 
user to make and receive calls at any MCDN node. When the handset user 
visits a MCDN node, the MSMN feature automatically performs the 
following actions:

• detects the visiting handset when it is on

• forwards calls to the visiting handset from the users home node
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The Call Forward dial tone indicates when MSMN activation was not 
successful. Turn the handset off and on again to re-activate the MSMN 
feature.

The MSMN feature requires concentrated DMCs.

A non-concentrated system has each handset configured to a DMC8 TN. A 
non-concentrated DMC8 has 32 handset TNs assigned to 32 time slots and is 
non-blocking. 

A concentrated system has each handset configured to a Virtual TN (VTN) 
on phantom loops. Concentration allows up to 510 handsets to share the 
DMCs 32 time slots and is a blocking system. See “DECT Concentration 
Traffic” on page 151.

Separate DECT systems on a Meridian PBX can be concentrated or 
non-concentrated.

Operating parameters
The MSMN feature can not support a mix of concentrated DMCs and 
non-concentrated DMCs within the same DECT system.

All DMCs, either new, empty for redundancy, or used for base station 
coverage, must have at least one handset configured to ensure system 
operation.

The C4010/C4020 handset can subscribe to a maximum of eight DECT 
systems.

The C4050 handset can subscribe to a maximum of eight DECT systems.

Feature interactions
Call forward from a MADN handset
A MADN handset at a remote node can activate Call Forward (CFW) at the 
home node. When the handset shares a DN with another set(s), the CFW lamp 
lights on the shared DN set(s). If the handset is not the MARP, the shared DN 
MARP set can cancel call forward. If the handset is the MARP, the handset 
overrides any call forward which is setup from other shared DN set(s).
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Card audit
Card audit does not work with VTNs.

Network Message Service
The MSMN feature does not change the handling of unanswered network 
calls. The Meridian Mail or Call Pilot network mail service does not change 
with multiple DNs configured against a single mailbox. The visiting DN 
receives the Message Waiting Indication (MWI) at the visited site.

Feature packaging
The MSMN feature requires the following packages:

• Multi-site Mobility Networking (MSMN) package 370

• Meridian 1 Companion Option (MCMO) package 240

• Phantom TN (PHTN) package 254

• Meridian Companion Enhanced Capacity (MC32) package 350

• Flexible Feature Codes (FFC) package 139

Installation and operation
For details on installing and operating the MSMN feature, refer to DECT 
Installation Guide (553-3601-203).
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DECT Concentration Traffic
Contents

This section contains information on the following topics:

System concentration. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
System capabilities and limits. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152

Blocking. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
Traffic assumptions used for table calculations. .  . . . . . . . . . . . . 153

Base station combinations for handsets on a DMC8 card. .  . . . . . . . . . 154
Low traffic for a 0.1 Erlang capacity. . . . . . . . . . . . . . . . . . . . . . . . . 154
Medium traffic for a 0.15 Erlang capacity. . . . . . . . . . . . . . . . . . . . . 154
High traffic for a 0.2 Erlang capacity. .. . . . . . . . . . . . . . . . . . . . . . . 156

Superloop and IPE shelf calculations. . . . . . . . . . . . . . . . . . . . . . . . . . . 157
Simplified guidelines. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157

System concentration
A Meridian DECT system without concentration supports a maximum 
number of 1024 handsets. With the concentration feature, in theory, the 
handset limit is 510 per DECT Mobility Card x 32 cards = 16320 handsets. 
However, in practice, traffic limits the number of handsets per card.

Each IPE card slot supports 32 channels of voice and data at the same time 
through the DS30X interface. Concentration removes the existing fixed ratio 
of 32 handsets per DMC.
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System capabilities and limits
Blocking

Calls in the DECT system can be blocked at many stages, including the 
following:

• At the base station – when all channels (6 or 12) of an base station are in 
use, calls through that base station (both to and from a PP) are rejected.

• At the Backbone interface – when the base stations of one DMC together 
have 32 radio connections, calls through those base stations (both to and 
from a handset) are rejected.

• At the IPE backplane Interface – when all 32 speech channels to the 
DS30X interface on the a DMC8 are occupied, calls to and from handsets 
which have that specific DMC8 as their home DMC8 are rejected.

• At the Network interface – usually the IPE shelf connectivity is a 
blocking configuration, where the number of network timeslots provided 
for a shelf is less than the actual number of terminals configured on that 
shelf.

Traffic definitions
Busy hour traffic – Busy hour traffic is the hour of the day during which a 
telephone system carries the most calls, voice or data. The unit for busy hour 
traffic is the Erlang or Centi Call Second (CCS).

Erlang – One Erlang is equal to the continuous use of a circuit for one hour.

CCS – One hundred Call Seconds (CCS) or 100 seconds of continuous use of 
a circuit. Normally referred to as CCS per hour. For example, a call on a 
circuit for one hour is equal to 36 CCS. 
(60 minutes x 60 seconds = 3600/100 = 36 CCS)

 Blocking – Blocking is a condition when a telephone call does not complete, 
and the calling party normally hears a busy signal.

Grade of Service – Grade of Service, given as a decimal fraction, indicates 
the probability of call blocking. For most applications, acceptable figures for 
blocking are between 0.01 and 0.03.
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Traffic assumptions used for table calculations
The following are traffic assumptions used for table calculations:

• A handset that always has good radio contact with a base station assumes 
that the radio deployment is acceptable.

• The Grade of Service used in all calculations is 1%.

• There is little or no overlap between base stations. (In practice, there is 
overlap, but to apply standard traffic calculations, it is necessary to 
simplify the calculation). For example, where there are two 6-channel 
base stations in the same cell, they will deliver a higher traffic flow.

• Ignore radio channels for handover. The traffic calculations allocate a 
slightly higher traffic capability to a base station than it can have in 
practice.

• Blocking occurs at three main areas: the base stations, the backplane, and 
the network loops. The traffic calculations only use the Erlang values 
where blocking occurs. For example, if there are three areas each 
delivering 10 Erlangs, traffic calculations take the total traffic capability 
as 10 Erlangs, not as 30 Erlangs. Real traffic capacity in this example is 
possibly more than 10 Erlangs.

• Handset handover continues without interruption.

• Handsets are distributed equally between the system DMC cards.

• All calculations are based on resident handset users. Visiting handset 
users have a negligible effect on traffic. In unusual circumstances where 
a site has a large number of visiting handset users, traffic capacity can 
require adjustments.
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Base station combinations for handsets 
on a DMC8 card

Low traffic for a 0.1 Erlang capacity
Table 7 shows the 6-channel and 12-channel base station combinations 
required to support a maximum number of handsets on a DMC card. The 
calculations are based on each handset generating 0.1 Erlangs of traffic. 

Table 7
Number of handsets for a 0.1 Erlang capacity

Number of 12-channel  base stations

0 1 2 3 4 5 6 7 8

Number 
of

6-channel
base 

stations

0 0 58 117 176 176 220 220 220 220

1 19 77 136 195 220 220 220 220

2 38 97 155 214 220 220 220

3 57 116 174 220 220 220

4 76 135 194 220 220

5 95 154 213 220

6 114 173 220

7 133 192

8 152
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Medium traffic for a 0.15 Erlang capacity
Table 8 shows the 6-channel and 12-channel base station combinations 
required to support a maximum number of handsets on a DMC card. The 
calculations are based on each handset generating 0.15 Erlangs of traffic. 

Table 8
Number of handsets for a 0.15 Erlang capacity

Number of 12-channel  base stations

0 1 2 3 4 5 6 7 8

Number 
of

6-channel
base 

stations

0 0 39 78 117 146 146 146 146 146

1 12 51 91 130 146 146 146 146

2 25 64 103 143 146 146 146

3 38 77 116 146 146 146

4 50 90 129 146 146

5 30 102 146 146

6 76 115

7 89 128

8 101
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High traffic for a 0.2 Erlang capacity
Table 9 shows the 6-channel and 12-channel base station combinations 
required to support a maximum number of handsets on a DMC card. The 
calculations are based on each handset generating 0.2 Erlangs of traffic. 

Table 9
Number of handsets for a 0.2 Erlang capacity

Number of 12-channel  base stations

0 1 2 3 4 5 6 7 8

Number 
of

6-channel
base 

stations

0 0 29 58 88 110 110 110 110 110

1 9 38 68 97 110 110 110 110

2 19 48 77 107 110 110 110

3 28 58 87 110 110 110

4 38 67 97 110 110

5 47 77 106 110

6 57 86 110

7 66 96

8 76
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Superloop and IPE shelf calculations
Table 10 shows the maximum number of handset users on a DMC8 card for 
varying traffic levels. This table includes the Option 11, with its non-blocking 
system architecture. 

Note: Superloops do not apply to the Option 11C Mini or Succession 
CSE 1000 systems.

Simplified guidelines
Use Table 10 to calculate the superloop capacity. 

Low traffic example of one superloop on each IPE shelf
69 handsets per DMC8 card x 16 DMC8 cards per shelf = 1104 (1000)

Medium traffic example of one superloop on each IPE shelf
46 handsets per DMC8 card x 16 DMC8 cards per shelf = 736 (750)

High traffic example of one superloop on each IPE shelf
34 handsets per DMC8 card x 16 DMC8 cards per shelf = 544 (500)

Table 10
Handset capacity/DMC8 for Superloop/IPE

Superloops for 
each IPE shel f

Low traff ic 
0.1 Erlang

Medium t raff ic  
0 .15  Erlang

High traff ic 
0.2 Erlang

2 138 handsets/DMC 92 handsets/DMC 69 handsets/DMC

1 69 handsets/DMC 46 handsets/DMC 34 handsets/DMC

0.5 34 handsets/DMC 23 handsets/DMC 17 handsets/DMC

Option 11 220 handsets/DMC 146 handsets/DMC 110 handsets/DMC
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DECT Messaging and alarm notification
Contents

This section contains information on the following topics:

DECT Messaging overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159
Messaging Server . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160
Alarms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
Handsets . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161

Reference list
The following are the references in this section:

• DECT Messaging (P0989045)

DECT Messaging overview
The DECT Messaging system allows text messages to be sent to and from 
C4040 and C4050 handsets. When there is an incoming message, the handset 
alerts the user in various ways, depending on the message’s priority. 

DECT Messaging is a data system. It operates independently of the voice 
system. Text messages can be received even if the handset is in use. (The only 
exception is if the handset is ringing.)
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Figure 83
DECT Messaging system overview

Messaging Server
The DECT Messaging system uses a Messaging Server that interfaces to the 
DECT system through a DMC8 card. The Messaging Server acts as an 
interface between the DECT system to external systems and applications, 
such as alarms.

The Messaging Server supports two standard interfaces to connect to external 
systems:

• Telelocator Alphanumeric Protocol (TAP) over a serial link

• Simple Network Paging Protocol (SNPP) over IP
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The Messaging Server provides the following functionality:

• the ability to send messages to a DECT handset from a standard web 
browser

• connection from external paging systems into the DECT system using 
standard protocols and interfaces. It supports both hard-wired serial 
connections and dial-up over modems.

• handset-to-handset messaging

• connection over the IP network to the DECT system

• standard interfaces to allow external applications to be built

• web management of subscriber information and configuration data

• an audit trail of all messages and responses kept by the system. These can 
be time-stamped to allow administrators to see what has happened at 
particular times, and to allow statistics to be generated.

Alarms
External applications, such as alarms and radio paging replacement, are 
supported by DECT Messaging. When an external alarm is triggered from the 
alarm system, the alarm sends a text message to the DECT Messaging system. 
The DECT Messaging system forwards the text message to the DECT 
handset.

External systems can be connected using TAP and SNPP protocols. The 
supported protocols are as follows:

• SNPP RFC1861 – for LAN access

• TAP v1.8 – for external paging systems

Handsets
DECT Messaging supports the Nortel Networks C4040 handset with 
software Version 11 (and later), and the C4050 handset. Both handsets 
support text messaging for messages to a maximum of 48 characters in length. 

The handsets are subscribed to the DECT system using OTM.

For more detailed information on DECT Messaging, refer to 
DECT Messaging (P0989045).
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DECT provisioning records
The DECT provisioning records include the following:

• a System information record

• a Provisioning information record

• an Installation record

• a System programming record

• a Portable user information record

Keep a copy of these records at the customer site. Vendors maintaining the 
DECT system also need a copy of the records.

See DECT Provisioning Records (553-3601-102).
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